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Introduction

Welcome to Adobe Illustrator CS6 on Demand, a visual quick
reference book that shows you how to work efficiently with
Illustrator.  This book provides complete coverage of basic to
advanced Illustrator skills.

How This Book Works
You don’t have to read this book in any particular order.
We’ve designed the book so that you can jump in, get the
information you need, and jump out. However, the book does
follow a logical progression from simple tasks to more com-
plex ones. Each task is presented on no more than two facing
pages, which lets you focus on a single task without having
to turn the page. To find the information that you need, just
look up the task in the table of contents or index, and turn to
the page listed. Read the task introduction, follow the step-
by-step instructions in the left column along with screen illus-
trations in the right column, and you’re done.

What’s New
If you’re searching for what’s new in Illustrator CS6, just look
for the icon: New!. The new icon appears in the table of con-
tents and throughout this book so you can quickly and easily
identify a new or improved feature in Illustrator. A complete
description of each new feature appears in the New Features
guide in the back of this book.

Keyboard Shortcuts
Most menu commands have a keyboard equivalent, such as
Ctrl+P (Win) or A+P (Mac), as a quicker alternative to using
the mouse. A complete list of keyboard shortcuts is available
on the web at www.perspection.com and in the back of this
book.

How You’ll Learn

How This Book Works

What’s New

Keyboard Shortcuts

Step-by-Step Instructions

Real World Examples

Workshops

Adobe Certification

Get More on the Web

www.perspection.com
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Step-by-Step
Instructions
This book provides concise step-
by-step instructions that show you
“how” to accomplish a task. Each
set of instructions includes illus-
trations that directly correspond to
the easy-to-read steps. Also
included in the text are time-
savers, tables, and sidebars to
help you work more efficiently or
to teach you more in-depth infor-
mation. A “Did You Know?” pro-
vides tips and techniques to help
you work smarter, while a “See
Also” leads you to other parts of
the book containing related infor-
mation about the task. 

Real World Examples
This book uses real world exam-
ple files to give you a context in
which to use the task. By using
the example files, you won’t waste
time looking for or creating sam-
ple files. You get a start file and a
result file, so you can compare
your work. Not every topic needs
an example file, such as changing
options, so we provide a complete
list of the example files used
throughout the book. The example
files that you need for project
tasks along with a complete file
list are available on the web at
www.perspection.com.

Real world
examples help
you apply what
you’ve learned
to other tasks.

Illustrations
match the
numbered
steps.

Numbered
steps guide
you through
each task.

Did You Know? alerts
you to tips, techniques
and related information.

See Also points you to
related information in
the book.

Easy-to-follow
introductions
focus on a
single concept.

www.perspection.com


The Workshops
walk you through
in-depth projects
to help you put
Illustrator to
work.

Introduction xix

Workshops
This book shows you how to put
together the individual step-by-
step tasks into in-depth projects
with the Workshop. You start each
project with a sample file, work
through the steps, and then com-
pare your results with a project
results file at the end. The Work-
shop projects and associated files
are available on the web at
www.perspection.com or at
queondemand.com.

Adobe Certification
This book prepares you fully for
the Adobe Certified Expert (ACE)
exam for Adobe Illustrator CS6.
Each Adobe Certified Expert certifi-
cation level has a set of objec-
tives, which are organized into
broader skill sets. To prepare for
the certification exam, you should
review and perform each task
identified with an ACE objective to
confirm that you can meet the
requirements for the exam. Infor-
mation about the ACE program is
available in the back of this book.
The Adobe Certified Expert objec-
tives and the specific pages that
cover them are available on the
web at www.perspection.com.

www.perspection.com
www.perspection.com
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Get More on the Web
In addition to the information in
this book, you can also get more
information on the web to help
you get up-to-speed faster with
Illustrator CS6. Some of the infor-
mation includes: 

Transition Helpers
◆ Only New Features.

Download and print the new
feature tasks as a quick and
easy guide.

Productivity Tools
◆ Keyboard Shortcuts.

Download a list of keyboard
shortcuts to learn faster ways
to get the job done. Also
available in the back of this
book.

More Content
◆ Photographs. Download

photographs and other
graphics to use in your
Illustrator documents. 

◆ More Content. Download
new content developed after
publication.

You can access these additional
resources on the web at
www.perspection.com.

Additional
content 
is available
on the web. 

www.perspection.com


Applying Fills, Strokes, and
Gradients

Introduction

The Stroke panel makes it easy to change stroke attributes,
such as weight (width), position on the path, and its style. The
weight of a stroke refers to the thickness of the line. The
Eyedropper tool on the Tools panel is another way you can
quickly pick up an object’s color and stroke attributes and
apply them to another object. Instead of using a solid color
as an object fill, you can create and use patterns. The process
is very simple. In Illustrator, create a pattern using drawing
tools, select and drag the object pattern to the Swatches
panel, and then give it a name. 

A blend uses two or more objects to create a transitional
object in between. If you’re just getting start with blends, the
Make command on the Blend submenu is an easy way to cre-
ate a blend. All you need to do is select the objects that you
want to use, and then choose the command. That’s it. If you
want a little more control over the way a blend turns out, you
can specify options in the Blend Options dialog box. If you
want to specify the locations where the blend takes place,
you can use the Blend tool. Transparency, or the opacity level
of an object, is set in Illustrator by adjusting the Opacity
option in the Transparency or Control panels. Along with the
Opacity option is the blending mode, which blends colors
together for objects in a group as well as all the objects
below it.  

A gradient is a smooth transition between two or more
colors in an object. You can apply one of Illustrator’s built-in
gradients or create one of your own by using the Gradient
panel. There are two types of gradients: Radial (circular) and
Linear (horizontal). With the Gradient tool, you can edit gradi-
ent colors applied to the object by adding or changing color
stops, applying transparency, and changing gradient direc-
tion (linear) or angle (radial).  5

5
What You’ll Do

Apply Fill and Stroke Colors

Change Stroke Attributes and Style

Create Variable Stroke Widths

Use the Eyedropper Tool

Create, Edit, and Use Patterns as Fills

Blend Color Fills

Create Blends Automatically

Apply Blend Options

Create Blends with the Blend Tool

Modify Blend Objects

Set Transparency Options

Create Transparency Masks

Flatten Object Transparency

Control Transparency Effects

Use the Transparency Grid

Apply, Create, and Edit Gradients

Use Gradient Libraries

Use the Gradient Tool

Create a Gradient Mesh

135
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Eyedropper
tool

Color Picker dialog box

Color panel

Swatches panel

Stroke color

Fill color

The Tools panel provides color boxes to make it easy for you to apply
fill and stroke colors. The color box in the foreground is the Fill box and
the outlined box in the background is the Stroke box. When you select
an object, fill, or stroke, the color boxes (also known as thumbnails), on
the Tools panel display the current colors. To change the fill or stroke
color, select an object, fill or stroke, select the Fill or Stroke box, and
then select a color from the Color, Swatches, or Color Guide panel, or
use the Eyedropper to apply a color from the active document.

Applying Fill and
Stroke Colors

Apply Colors to an Object, Fill or
Stroke

Select an object, fill, or stroke
using the appropriate selection
tool. 

Click the Fill or Stroke color box
on the Tools or Color panel to
choose the color's destination.

Click the Color icon on the Tools
panel to apply a color or click the
None icon to apply no color.

Use any of the following methods
to change the active fill or stroke
colors:

◆ Select the Swatches panel, and
then click a color swatch to
change the color. 

◆ Select the Color panel, and
then specify a color using the
controls.

◆ Select the Color Guide panel,
and then click a color swatch
to change the color. 

◆ Select the Eyedropper tool on
the Tools panel, and then click
anywhere in the active
document to change the color. 

◆ Double-click the Fill or Stroke
color box to open the Color
Picker dialog box, select a
color or enter color values, and
then click OK.

4

3

2

1

None icon

Color icon
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Use Default and Switch the Fill
and Stroke Colors

Click the Default Fill and Stroke
Colors buttons to revert the fill and
stroke colors to their default
values of black and white.

Click the Swap Fill and Stroke
Colors button to switch current
colors.

TIMESAVER Press D to
change the fill and stroke colors to
their default values of black and
white, and press X to switch the
current colors.

2

1

2

1

Did You Know?
You can add colors from the Color
Picker to the Swatches panel. Open
the Color Picker dialog box, select the
color you want to add to the Swatches
panel, click Add To Swatches, type a
name for the color, and then click OK.
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The Stroke panel makes it easy to change stroke attributes, such as
weight (width), position on the path, and its style. The weight of a
stroke represents the thickness of the line. A weight smaller than .25
may not print and a weight of 0 removes the stroke. In addition to the
width of a stroke, you can also specify the position (known as align-
ment) of the stroke on the path (either center, inside, or outside) and
change the caps or joins of a stroke to sharpen or round endpoints and
corners. A cap is the end of an open line, while a join is a corner.

Changing Stroke
Attributes

Change the Weight of a Stroke 

Select one or more objects.

Select the Stroke panel.

Specify or enter a weight in the
Stroke or Control panel.

◆ Click the up or down arrow, or
Shift+click to change the
weight by a larger interval.

Change the Alignment of a
Stroke on the Path

Select one or more closed objects.

Select the Stroke panel.

Click one of the following
alignment buttons:

◆ Align Stroke to Center.

◆ Align Stroke to Inside.

◆ Align Stroke to Outside.

3

2

1

3

2

1 1 2 3

21 3
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Change Stroke Caps or Joins 

Select one or more objects. 

Select the Stroke panel.

To change the endpoints, click one
of the following buttons:

◆ Butt Cap. Creates a square-
edged end.

◆ Round Cap. Creates a rounded
end.

◆ Projecting Cap. Creates a
square-edged end that extends
past the endpoint.

To change the bends on corner
points, click one of the following:

◆ Miter Join. Creates a pointed
join point.

◆ Enter a miter limit between 1
and 500. When the length of
the point reaches the limit
(default 4) times the stroke
weight, Illustrator switches
from a miter join to a bevel
join. 

◆ Round Join. Creates a rounded
join point.

◆ Bevel Join. Creates a beveled
(cut off) join point.

4

3

2

1

1

2

4

3
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Style is what stands out on the page. You can change the stroke style
by applying dashes and arrowheads using the Stroke panel. When you
create a dashed stroke, you can choose to align the dashes around
corners and at the end of open paths or preserve the dashes and gaps
in the stroke. In addition to dashes, you can also add and define an
arrowhead to a stroke. After you add an arrowhead to a stroke, you can
adjust its alignment and scale.

Changing Stroke Style

Create a Dashed Stroke

Select one or more objects. 

Select the Stroke panel.

Select the Dashed Line check box.

Click the Preserve Exact Dash and
Gap Lengths or Aligns Dashes to
Corners and Path Ends, Adjusting
Lengths to Fit icon.

Enter a value in the first Dash box.

If you don’t enter any more values,
the value in the first box is used
for the rest of the boxes.

Enter a value in the first Gap box.

Fill in the remaining boxes.

◆ To create a dotted line, click the
Round Cap button, enter a dash
value of 0, and then enter a gap
value greater than or equal to
the stroke weight.

Click one of the Cap buttons to
sharpen or round endpoints.

8

7

6

5

4

3

2

1

5 6

1
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Add Arrowheads

Select one or more objects. 

Select the Stroke panel.

Click the Start Point Arrowhead or
End Point Arrowhead list arrow,
and then select an arrowhead.

◆ To remove an arrowhead,
select None from the list.

To swap the start and end
arrowheads, click the Swap Start
And End Arrowheads button. 

Click the Start Arrowhead Scale
or End Arrowhead Scale list
arrow, and then drag a scale
percentage for the arrowhead.

◆ To link the start and end
arrowhead scale, click the Link
Start And End Arrowhead
Scales button.

To change the arrowhead
alignment, click the Extend Arrow
Tip Beyond End Of Path or Place
Arrow Tip At End Of Path button.
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Did You Know?
You can customize arrowheads. To
define custom arrowheads, open the
Arrowheads.ai file, follow the direc-
tions in the file, and then place the
updated Arrowheads.ai file in the
<Illustrator home>\plug-ins\. 

The Arrowheads.ai file is located under
ShowPackageContent\Required\
Resources\<locale>\ (Mac) or \Support
Files\Required\Resources\,<locale>\
(Win).
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The Width tool allows you to create a variable width stroke and save
your settings as a profile that you can apply to other strokes. When you
point to a stroke with the Width tool, a small circle appears on the path,
where you can drag to create a variable width. After you create a vari-
able width, you can move, duplicate, or delete a width point on the
path. Each width point contains an inward/outward handle, which you
can drag on the path to adjust the width. If you want to create a vari-
able width with exact measurements, you can use the Width Point Edit
dialog box. After you create a variable width point, you can save it as a
profile from the Stroke or Control panel. 

Creating Variable
Stroke Widths

Create or Adjust a Variable
Stroke Width

Select the Width tool on the Tools
panel. 

Use any of the following methods
to create and adjust a variable
width stroke:

◆ Create a Variable Width Point.
Point to the path, and then click
on the path and drag to size it.

◆ Change a Variable Width Point
Position. Point to the path,
point to a width point, and then
drag it along the path.

◆ Change a Variable Width Point
Size. Point to the path, point to
a width point, and then drag the
inward/outward handle.

◆ Set Exact Variable Width Point
Sizes and Options. Point to the
path, double-click the width
point, specify the sizes you
want, select the Adjust
Adjoining Width Points check
box to adjust neighboring width
points, and then click OK. 

◆ Delete a Variable Width Point.
Point to the path, click the
width point, and then press
Delete.

◆ Select Multiple Width Points.
Point to the path, press Shift
and click width points.
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Set exact variable width point sizes and options

Adjust Adjoining Width Points check box

Variable width point on path

Inward/outward handle
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Width Control Keyboard Shortcuts (Win/Mac)

Create non-uniform widths Alt/Option+drag

Create a copy of a width point Alt/Option+drag

Copy/move all points along the path Alt/Option+Shift+drag

Move multiple width points Shift+drag

Select multiple width points Shift+click

Delete selected width points Delete

Deselect a width point Esc

Width Tool Shortcuts

Create and Apply a Stroke 
Width Profile

Select the Width tool on the Tools
panel. 

Select the Stroke panel.

Use any of the following methods
to create or adjust a variable width
stroke:

◆ Create a Width Profile. Create
or select a variable stroke
width, click the Profile list
arrow on the Stroke panel, click
the Add To Profiles button, type
a name, and then click OK.

◆ Apply a Width Profile. Select a
path, click the Profile list arrow
on the Stroke panel, and then
select the width profile you
want.

◆ Remove a Width Profile. Select
the variable stroke width you
want to remove, click the
Profile list arrow on the Stroke
panel, and then click Uniform.

◆ Flip a Width Profile. Click the
Profile list arrow on the Stroke
panel, select the profile you
want to flip, and then click the
Flip Along or Flip Across
button.

◆ Delete a Width Profile. Click
the Profile list arrow on the
Stroke panel, select the profile
you want to delete, and then
click the Delete Profile button,
and then click Yes.

◆ Restore the Default Width
Profile Set. Click the Profile list
arrow on the Stroke panel, click
the Reset Profiles button, and
then click OK. This removes any
custom saved profiles.

3

2

1

1

Variable width stroke
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Profile list arrow

Add To Profiles,
Delete Profile,
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Flip buttons
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The Eyedropper tool on the Tools panel makes it easy to quickly pick up
a color from one area of your artwork and apply it to another area.
When you click an object with the Eyedropper tool, it picks up the
object’s color and stroke attributes and displays them in the Tools,
Color, and Stroke panels. You can pick up attributes from any type of
object, even a graphic image and the object doesn’t need to be
selected. If an object is selected, the color and stroke attributes are
applied to the selected object. The Eyedropper tool also provides
options for you to customize the attributes—such as Appearance,
Transparency, Focal Fill and Focal Stroke, Character Style and
Paragraph Style—that you want to pick up with the tool.

Using the Eyedropper
Tool

Apply Colors and Attributes with
the Eyedropper Tool

If you want to apply the pick up
color and attributes to one or more
objects, then select them. 

Select the Eyedropper tool on the
Tools panel.

Click an object in any window that
contains the color and attributes
that you want to pick up and apply.

◆ If you want to apply color
attributes from the currently
selected object and apply them
to another object you select,
Alt+click (Win) or Option+click
(Mac) the objects. 

◆ To have the Eyedropper tool
only pick up an object’s color
and not other attributes, click
the Fill or Stroke box on the
Tools or Color panel, and then
Shift+click the color to be
picked up. 
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Change Eyedropper Options

Double-click the Eyedropper tool
on the Tools panel. 

In the left column, select the
check boxes for the options that
you want the Eyedropper to pick
up and deselect the ones you
don’t.

In the right column, select the
check boxes for the options that
you want the Eyedropper to apply
and deselect the ones you don’t.

Click the Raster Sample Size list
arrow, and then select a sample
size for the pick up color and
attributes.

Click OK.5
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Instead of using solid color or gradients as object fills, you can create
and use patterns. The process is very simple. In Illustrator, use existing
artwork (nothing with a painted pattern) or create a pattern using
tools—such as Rectangle, Ellipse, Polygon, Arc, Spiral, Star, or Flare—
on the Tools panel, and then drag it to the Swatches panel. If you want
to create a more complex pattern, you can make and edit patterns
using the Pattern Options panel (New!). The pattern consists of a
group of objects, which you can also edit using Isolation Mode.

Creating Patterns for
Fills

Create a Pattern for Fills

Use existing or draw objects to be
used as a pattern. 

Select the Selection tool on the
Tools panel.

Select all the objects.

Click the Object menu, point to
Pattern, and then click Make.

If prompted with an alert dialog
box, click OK.

The object is added to the
Swatches panel, the Pattern
Options panel opens, and the
pattern appears in Isolation Mode.

Type a name for the pattern.

Click the Tile Type list arrow, and
then select a layout: Grid, Brick by
Row, Brick by Column, Hex by
Column, or Hex by Row.

◆ Brick Offset. If you select one
of the brick title types, click the
Brick Offset list arrow, and
then select an offset.

To adjust tiling manually, click the
Pattern Tile Tool button, and then
drag a white square handle to
resize it.

Specify any of the following
options:

◆ Width and Height. If you want
an exact width and height,
specify the values you want.
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◆ Size Tile to Art. Select to size
the pattern tile to the applied
object. If you select his option,
specify horizontal (H) and
vertical (V) spacing.

◆ Move Tile with Art. Select to
move the pattern tile with the
applied object.

◆ Overlap. Select Left in Front or
Right in Front and Top in Front
or Bottom in Front.

Specify any of the following
options:

◆ Copies. Specify the number of
patterns you want in the grid.

◆ Dim Copies to a Percentage.
Select to dim the pattern copies
by an opacity percentage. 

◆ Show Tile Edge. Select to show
the edge of the pattern tile.

◆ Show Swatch Bounds. Select
to show the bounding edge of
the pattern swatch.

When you’re done modifying the
pattern, click Done on the gray bar
to exit Isolation Mode.

◆ Cancel. Click Cancel to exit
Isolation Mode with creating an
pattern.

◆ Save a Copy. Click Save a Copy
to create a copy of the pattern;
Enter a name, and then click
OK.
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Isolation Mode

Pattern based on Pattern Options panel
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Did You Know?
You can add an object to the
Swatches panel as pattern. Drag the
object selection to a blank area in the
Swatches panel.  
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After you create a pattern using the Pattern Options panel (New!), you
can use the Edit Pattern command (New!) on the Pattern submenu on
the Object menu to edit the pattern. When you edit a pattern from the
Swatches panel, the Pattern Options panel opens and the pattern
appears in Isolation Mode. With the Direction Selection tool, you can
edit individual objects in the pattern. With the Pattern Options panel,
you can edit how the pattern appears as a fill.

Editing Patterns

Edit a Pattern

Select the Swatches panel.

Select the pattern you want to
edit.

Click the Object menu, point to
Pattern, and then click Edit
Pattern.

The Pattern Options panel opens
and the pattern appears in
Isolation Mode.

With the Direct Selection tool, edit
individual objects in the pattern.

In the Pattern Options panel, make
the changes you want to pattern;
see the previous page for option
specifics.

To adjust tiling manually, click the
Pattern Tile Tool button, and then
drag a white square handle to
resize it in Isolation Mode.

When you’re done modifying the
pattern, click Done on the gray bar
to exit Isolation Mode.

◆ Cancel. Click Cancel to exit
Isolation Mode with creating a
pattern.

◆ Save a Copy. Click Save a Copy
to create a copy of the pattern;
enter a name, and then click
OK.
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After you create a pattern, you can apply the pattern from the
Swatches panel to an object’s fill or stroke. You can apply a pattern just
as you would apply a solid or gradient color. Simply, select the object,
select the Fill or Stroke color box on the Tools panel, and then click the
pattern you want to use from the Swatches panel.

Using Patterns as Fills

Use a Pattern as a Fill or Stroke

Select the Selection tool on the
Tools panel.

Select an object.

Click the Fill or Stroke color box
on the Tools panel.

Select the Swatches panel.

Click the pattern in the Swatches
panel.
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Pattern applied to object

Did You Know?
You can reposition a pattern fill. To
reposition the pattern fill or stroke in
an object without moving the object,
select the Selection tool, hold down 
~ (tilde) and drag inside the object. 

You can expand a pattern into individ-
ual objects. Select the object with the
pattern, click the Object menu, click
Expand, select the Fill check box
and/or the Stroke check box, and then
click OK.
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The Edit Color submenu allows you to blend fill colors for three or more
objects. The more objects that you select, the more gradual the color
blend. Stroke colors and attributes remain the same. Illustrator takes
the objects on the edges (front and back, left and right, and top and
bottom) as the starting and ending colors in the blend. All objects in
between the starting and ending ones are intermediate blends. 

Blending Fill Colors

Blend Fill Colors

Select three or more objects that
contain fill colors. 

◆ The objects cannot contain
global process colors, patterns,
or gradients.

Click the Edit menu, and then point
to Edit Colors.

Select any of the following
commands:

◆ Blend Front to Back. Uses the
fill color of the front and back
objects in the selection as the
starting and ending colors in
the blend.

◆ Blend Horizontally. Uses the fill
color of the left side and right
side objects as the starting and
ending colors in the blend. 

◆ Blend Vertically. Uses the fill
color of the top and bottom
objects as the starting and
ending colors in the blend. 
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If you’re just getting started with blends, the Make command on the
Blend submenu is an easy way to create a blend. All you need to do is
select the objects that you want to use in the blend, and then choose
the Make command. That’s it. Illustrator creates all the transitional
objects in between. If you don’t like the results, you can undo the blend
and try something else. If you no longer want the blend, you can
release it, which removes the transitional objects and leaves the origi-
nal objects and the path.

Creating Blends
Automatically

Make and Release Blend
Objects

Select two or more objects or
groups (with space in between
them) that you want to blend. 

Click the Object menu, point to
Blend, and then click Make.

◆ To undo the creation of the
blend objects, click the Edit
menu, and then click Undo.

Select the blend objects.

To release the blend objects, click
the Object menu, point to Blend,
and then click Release.

The transitional objects between
the original objects are removed,
while the original objects and path
remain intact.
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If you want a little more control over the way a blend turns out, you can
specify options in the Blend Options dialog box. The settings automati-
cally apply to any selected objects and future blends. The settings
include Smooth Color, Specified Steps (number of transitional steps),
Specified Distance, Align to Page, and Align to Path. The Preview
option allows you to view your changes on the screen as you make
them.

Applying Blend
Options

Change and Apply Blend
Options

Select an existing blend object. 

Click the Object menu, point to
Blend, and then click Blend
Options.

Select the Preview check box to
view your changes.

Click the Spacing list arrow, and
then select one of the following:

◆ Smooth Color. Select to
automatically create a smooth
color blend based on the
number of transitional steps
needed.

◆ Specified Steps. Enter the
number of transitional steps (1-
1000) that you want.

◆ Specified Distance. Enter the
distance (.1-1000 pixels)
between the transition objects
in the blend.

Select one of the following
orientation buttons:

◆ Align to Page. Click to align the
blend objects perpendicular to
the horizontal axes.

◆ Align to Path. Click to align the
blend objects perpendicular to
the path.

Click OK.6
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If you want to specify the locations where the blend takes place, you
can use the Blend tool on the Tools panel. The Blend tool allows you to
select the anchor points on the objects to determine the direction of
the blend. For the best results and smoothest transitions, click anchor
points on corresponding locations on the objects. If you’re not sure
which anchor points to use, you can also select an object’s fill to let
Illustrator select the anchor point for you. Experiment with it to deter-
mine what works best for you. 

Creating Blends with
the Blend Tool

Create a Blend with the Blend
Tool

Select two or more objects or
groups (with space in between
them) that you want to blend. 

Select the Blend tool on the Tools
panel.

Click the fill of the first object (not
the center point) to let Illustrator
determine an anchor point to use,
or click the anchor point that you
want to use.

Click the fill or an anchor point on
the next object. If the path is open,
click an endpoint.

For the best results and smoothest
transitions, click anchor points on
corresponding locations on the
objects.

Continue to click corresponding
anchor points on the selected
objects.

To release the blend objects,
select the blend, click the Object
menu, point to Blend, and then
click Release.
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After you create a blend, you can use commands on the Blend sub-
menu to reverse stacking order, reverse spine location, and replace the
spine. These commands allow you to quickly change the look of the
blend. If you want to modify a blend, you can change blend objects
using other Illustrator features, such as recoloring, reshaping, or trans-
forming. Experiment to determine what works best for you. 

Modifying Blend
Objects

Modify Blend Objects

◆ Reverse Stacking Order. Changes
the stacking order (front to back)
without changing the x/y location.
Select a blend object, click the
Object menu, point to Blend, and
then click Reverse Front to Back. 

◆ Reverse Spine. Changes the x/y
location of the blend objects
without changing the stacking
order. Select a blend object, click
the Object menu, point to Blend,
and then click Reverse Spine. 

◆ Replace Spine. Replaces the
current spine in a blend with a
new path. Create a new path for
the spine, select a blend object
and the new path, click the Object
menu, point to Blend, and then
click Replace Spine. 

◆ Recolor. Select all the objects in
the blend that you want to recolor,
click the Recolor Artwork button
on the Control panel, specify the
color changes you want, and then
click OK.

◆ Transform. Select all the objects in
the blend, and then use the
object’s bounding box, the Free
Transform tool, or other
transformation tools.

◆ Reshape Path. Move one of the
original blend objects with the
Direct Selection tool or use any of
the reshaping path tools.

Edit blend

Reverse spine location

Reshape path

Blend transformed
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Transparency, or the opacity of an object (to what degree you can see
through the object), is set in Illustrator by adjusting the Opacity option
in the Transparency, Control, or Appearance panels. The Opacity option
allows you to specify a percentage to set the transparency level. Along
with opacity, you an also change the blending mode, which controls
how object colors blend with other object colors below it. You can
apply transparency options to an object, group, or layer. This includes
an object’s fill or stroke, and type. 

Setting Transparency
Options

Change the Opacity or Blending
Mode of an Object

Select an object, group, or layer.

◆ For a layer, click the target
circle on the Layers panel. 

◆ For type, select individual
characters or the entire object.

◆ For an object’s fill or stroke,
click the target circle on the
Layers panel, and then click Fill
or Stroke on the Appearance
panel.

Select the Transparency panel.

To change opacity, click the
Opacity list arrow, and then
specify a percentage.

To change the blending mode,
click the Blending Mode list
arrow, and then select a blending
mode.
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When you apply a blending mode to a group, the blend is applied to all
the objects in the group as well as all the objects below it. If you want
to isolate the blend to only the objects nested in the group, you can use
the Isolate Blending option in the Transparency panel. You can also use
the option on individual objects with overlapping strokes and fills. If
objects in a group overlap, you can use the Knockout Group option to
control whether objects will show through each other (except for semi-
transparent objects) or be knocked out. 

Controlling
Transparency Effects

Isolate a Blending Mode to
Certain Objects

Click the target circle for a group
or layer on the Layers panel that
contains nested objects with a
blending mode. 

Select the Transparency panel.

Click the Options menu, and then
click Page Isolated Blending.

Use the Knockout Group Option

Click the target circle for a group
or layer on the Layers panel that
contains nested objects. 

Select the Transparency panel.

Click the Options menu, and then
click Page Knockout Group to
knock out the objects so that you
can't see through them. However,
you’ll still see through any semi-
transparent objects. Deselect this
option to allow objects to be seen
through each other. 
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You can use an opacity mask and a masking object to change trans-
parency. The opacity mask is an object whose shape masks out every-
thing except the contents behind the shape. The masking object is the
area that becomes transparent. You can use any colored object or
raster image as the masking object. When the opacity mask is white,
the artwork is fully visible. When the opacity mask is black, the artwork
is hidden. Using shades of gray in the mask provides the varying opac-
ity levels of transparency in the artwork. You can create an opacity
mask in the Transparency panel.

Creating Transparency
Masks

Use Opacity Masks to Create
Transparency

Select two or more objects or
groups.

Select the Transparency panel.

Click Make Mask on the
Transparency panel.

The Clip check box becomes
selected. The Clip option sets the
mask background to black. If you
have black objects, they will be
hidden, unless you use a different
color or deselect the Clip check
box.

To reverse the opacity of the
masked artwork (80% transparent
becomes 20% transparent), select
the Invert Mask check box. 

◆ You can also change opacity
with the Opacity list arrow. 

To edit a masking object, click the
thumbnail (on right), edit the mask,
and then click the masked artwork
thumbnail (on left) to exit.

◆ Alt-click (Win) or Option-click
(Mac) the thumbnail to hide all
other artwork in the document. 

To unlink or relink an opacity mask,
click the Link icon between the
thumbnails.

To remove an opacity mask, click
Release on the Transparency
panel.
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If you have problems printing or saving artwork with transparent
objects, you can use the Flatten Transparency command on the Object
menu to flatten the object. In most cases when you’re working with
legacy artwork, this will fix the problem. The best way to flatten the
transparency within an object is to try one of the presets. Otherwise,
you can specify your own settings. If you plan to use the settings in the
future, you can save them as a custom preset.

Flattening Object
Transparency

Flatten Object Transparency

Select the objects you want to
change.

Click the Object menu, and then
click Flatten Transparency.

Click the Preset list arrow, and then
select a preset.

Click OK to use the preset, or
specify the custom settings:

◆ Raster/Vector Balance.
Preserves vector information.

◆ Line Art and Text Resolution.
Rasterizes art and text objects;
typically set to 600-1200. 

◆ Gradient and Mesh Resolution.
Rasterizes gradient and mesh
objects; typically set to 72-2400. 

◆ Convert All Text to Outlines.
Select to convert to outlines;
discards all type glyph info. 

◆ Convert All Strokes to Outlines.
Select to convert strokes to
filled paths. 

◆ Clip Complex Regions. Select to
reduce stitching where rasters
and vectors meet. 

◆ Anti-alias Rasters. Select to
smooth raster images (New!). 

◆ Preserve Alpha Transparency.
Select to retain appearance and
transparency. 

◆ Preserve Overprints and Spot
Colors. Select when printing
separations. 

To save the custom settings, click
Save Preset, enter a name, and
then click OK.
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The Transparency grid makes it easier to work with semi-transparent
objects. The gray and white checkerboard background allows you to
distinguish between different levels of transparencies. You can quickly
show or hide the transparency grid by using the Show Transparency
Grid command on the View menu. Before you use the command, you
can customize the look of the grid in the Document Setup dialog box. 

Using the
Transparency Grid

Select Transparency Grid
Preferences

Click the File menu, and then click
Document Setup. 

Click the Grid Size list arrow, and
then select a size: Small, Medium,
or Large. 

Click the Grid Colors list arrow,
and then select a color: Light,
Medium, Dark, or a specific color.

Select the Simulate Colored Paper
check box to simulate the use of
colored paper, which blends with
objects. 

Click the Preset list arrow, and
then select a resolution.

Click OK.6
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Did You Know?
You can show and hide the trans-
parency grid. Click the view menu, and
then click Show Transparency Grid or
Hide Transparency Grid.
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A gradient is a smooth transition between two or more colors in an
object. You can apply one of Illustrator’s built-in gradients or create one
of your own by using the Gradient panel. The built-in gradients are
available from gradient libraries. You can apply a gradient to an object’s
fill or stroke (New!). After you apply a gradient, you can change the
direction or smoothness of the color transition.

Applying Gradients

Apply a Gradient Fill to an
Object

Select an object with the fill you
want to change.

◆ For type, convert it to outlines
(click the Type menu, and then
click Create Outlines), or select
the type, and then select Add
New Fill from the Appearance
panel menu.

Select the Swatches and Gradient
panels.

◆ To use gradients from a
gradient library, click the
Swatch Libraries menu on the
Swatches panel, point to
Gradient, select a gradient
library, and then click a
gradient.

Click the Fill color box on the
Gradient (New!) or Tools panel.

Click a gradient swatch on the
Swatches panel or use the
Gradient Fill box list arrow on the
Gradient panel to apply any of the
gradients on the Swatches panel.

To change the direction of the
gradient, click the Reverse
Gradient button.
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Apply a Gradient to a Stroke

Select an object with the stroke
you want to change.

Select the Swatches and Gradient
panels.

◆ To use gradients from a
gradient library, click the
Swatch Libraries menu on the
Swatches panel, point to
Gradient, select a gradient
library, and then click a
gradient.

Click the Stroke color box on the
Gradient (New!) or Tools panel.

Click a gradient swatch on the
Swatches panel or use the
Gradient Fill box list arrow on the
Gradient panel to apply any of the
gradients on the Swatches panel.

Click a stroke button (New!) to
specify where to apply the
gradient:

◆ Within Stroke. 

◆ Along Stroke. 

◆ Across Stroke. 

To change the direction of the
gradient, click the Reverse
Gradient button.
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Did You Know?
You can expand a gradient fill to cre-
ate an effect. Select an object with a
gradient fill, click the Object menu,
click Expand, click the Specify option
in the Expand Gradient To area, and
then enter the number of objects that
you want to create. For a smooth color
transition, enter a large number (100),
and then click OK.
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You can apply one of Illustrator’s built-in gradients or create one of your
own by using the Gradient panel. The built-in gradients are available
from gradient libraries, which you can access from the Swatches panel.
The gradient libraries open in a panel, displaying individual gradients.
When you select a swatch from a gradient library, it’s automatically
added to the Swatches panel. You can apply a gradient to an object’s fill
or stroke using the Swatches, gradient library, or Gradient panels.

Using Gradients
Libraries  

Add Library Gradients to the
Swatches Panel

Select the Swatches panel.

Click the Swatch Libraries menu
on the Swatches panel, point to
Gradient, and then select a
gradient library.

Click a gradient swatch on the
gradient library panel.

The swatch from a gradient library
is automatically added to the
Swatches panel, where you can
apply it to fills and strokes.
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Instead of using one of Illustrator’s built-in gradients, you can create
your own by using the Gradient panel. It’s easy and you can be creative
in the process. You can create a gradient with two or more colors and
add transparency. There are two types of gradients: Radial (circular)
and Linear (horizontal). After you create a gradient, you need to save it
in the Swatches panel in order to use it again later. 

Creating Gradients

Create a Gradient Fill for an
Object

Select an object.

Select the Gradient panel.

Click the Gradient Fill box on the
Gradient panel.

Click the left color stop and use
the Color panel to create the color
you want, or Alt+click (Win) or
Option+click (Mac) a color swatch
on the Swatches panel.

Repeat the previous step for the
right color stop.

Click the Type list arrow, and then
select a gradient type: Radial or
Linear.

To add color stops, click below the
gradient spectrum in a blank area.
To remove a color stop, drag it
down and away from the gradient
spectrum.

To adjust the amount of each color
in the gradient, drag the diamond
above the gradient spectrum.

To add transparency, select a
color stop, and then specify an
Opacity value. 

To save the gradient, drag the
Gradient Fill box from the Gradient
panel to the Swatches panel. 

◆ To save and name the gradient,
click the Gradient Fill box on
the Gradient panel, click the
New Swatch button on the
Swatches panel, enter a name,
and then click OK.
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After you apply a built-in gradient or use one of your own, you can edit
it. You can edit a gradient in an object and keep the gradient in the
Swatches panel unchanged or you can edit the gradient in the
Swatches panel and keep the gradient in an object unchanged. Editing
a gradient is similar to creating one. The techniques are the same. All
you need to do is select the element that you want to edit. 

Editing Gradients

Edit a Gradient

Select an object with a gradient,
or click the gradient swatch on the
Swatches panel you want to edit.

Select the Gradient panel.

Click the Gradient Fill box on the
Gradient panel, or click the
Gradient Fill box list arrow, and
then select one of the saved
gradients (from Swatches panel).

To change the gradient type, click
the Type list arrow, and then select
a gradient type: Radial or Linear.

Do any of the following:

◆ Add color stops. Click below
the gradient spectrum in a
blank area. 

◆ Remove color stops. Drag the
color stop down and away from
the gradient spectrum.

◆ Move color stops. Drag the
color stop or enter a Location
value.

◆ Duplicate color stops. Alt+drag
(Win) or Option+drag (Mac) a
color stop. 

◆ Adjust color amount. Drag the
diamond above the gradient
spectrum.

◆ Change Transparency. Select a
color stop, and then specify an
Opacity value. 

To save the gradient, Alt-drag
(Win) or Option-drag (Mac) the
Gradient Fill box from the Gradient
panel over the old gradient on the
Swatches panel. 

6
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The Gradient tool on the Tools panel allows you to change how a gradi-
ent appears for an object. You can change how gradient colors blend,
the angle of a linear gradient, and the location of the center for a radial
gradient with a drag of the mouse over the gradient fill. You can also
edit gradient colors on the object by adding or changing color stops,
applying transparency to color stops, and changing gradient direction
(linear) or angle (radial) using the Gradient Annotator, which you can
show and hide from the View menu.

Using the Gradient
Tool

Use the Gradient Tool to Change
a Gradient

Select an object with a gradient
that you want to change.

Click the Gradient tool on the Tools
panel.

Click the View menu, and then
click Show Gradient Annotator.

Do any of the following:

◆ Short Color Transitions. Drag
the diamond icon on the object
a short distance. 

◆ Gradual Color Transitions. Drag
the diamond icon on the object
a long distance.

◆ Change Position. Drag the
larger circle on the object.

◆ Reverse Color Direction. Drag
the diamond icon on the object
in the opposite direction.

◆ Change Radial Center. Drag the
small circle attached to the
larger circle on the object. 

◆ Change Linear Angle. Alt+drag
(Win) or Option+drag (Mac) the
diamond icon to another angle.

◆ Change Color Stops. Click
below the spectrum line to add,
drag to move, and drag away to
remove color stops. 

◆ Change Transparency. Double-
click a color stop on the object,
and then specify an Opacity
value in the Gradient panel. 
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A mesh object is a multicolored gradient type object that allows colors
to flow in different directions and transitions from one point to another.
A mesh object uses mesh lines (like a grid) to make it easier for you to
modify color flow, transitions, intensity, and opacity. The points in the
grid are called mesh points (diamonds). Mesh points are like anchor
points, except you can assign color and transparency to them. The
area between four mesh points is a mesh patch for which you can
modify the color and transparency. You can create two types of mesh
objects: one with an irregular pattern of mesh points or one with a reg-
ular pattern of mesh points.

Creating a Gradient
Mesh

Create a Gradient Mesh

Select an object.

Do one of the following:

◆ Irregular Pattern. Select the
Mesh tool on the Tools panel,
select a fill color for mesh
points, click to place the first
mesh point, and then continue
to click to place other mesh
points. 

◆ Regular Pattern. Click the
Object menu, and then click
Create Gradient Mesh. Set the
number of rows and columns,
select the highlight direction,
enter a percentage of white
highlight (100% = white, 0% =
no white), and then click OK.

To edit a mesh object, select the
Mesh tool on the Tools panel, and
then do any of the following:

◆ Delete Mesh Point. Alt-click
(Win) or Option-click (Mac) a
mesh point to delete it.

◆ Move Mesh Point. Drag to
move a mesh point. Shift-drag
to keep the mesh point on a
mesh line.

◆ Add Mesh Point. Select a color
for the new mesh point, and
then click to add a mesh point.
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Set Color and Transparency for a
Gradient Mesh

Select the Mesh tool on the Tools
panel.

Select one or more mesh points or
patches on the object.

To change the color of a mesh
point or path, drag a color from the
Color or Swatches panel onto the
point or patch. 

◆ You can also deselect all
objects, select a fill color, and
then select the mesh object
and use the Eyedropper tool to
apply the full color.

Select the Transparency panel.

Click the Opacity list arrow, and
then specify a percentage.

IMPORTANT If you save the
object to the CS5 format, or EPS or
PDF, the transparency on the mesh
object is retained by creating a
opacity mask.

5

4
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Did You Know?
You can convert a gradient to a mesh
object. Select an object with a gradient
fill, click the Object menu, click
Expand, click the Gradient Mesh
option, and then click OK.

You can convert a mesh object back to
a path object. Select the mesh object,
click the Object menu, point to Path,
click Offset Path, enter zero for the off-
set value, and then click OK.

1

2 Selected mesh point
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Index

A
accented edges effects, 301
actions

Actions panel, 358–359
adding commands to, 364
adding stops to, 362
batch file processing, 366–367
building new, 360
built-in scripts, 368
controlling playback of, 361
deleting commands from, 365
inserting a non-recordable command in

an Action, 363
order of commands in, changing, 364
recording, 360
running actions within actions, 360
saving

as files, 359
into sets, 359

scripts, 368–369
activation, 2
active documents, 21
active windows, 20
Adobe.com, 450
Adobe Bridge

automating tasks in, 486
browsing documents with, 16
Camera Raw feature, 476–479
color settings, 109
components of, 473
description of, 472
editing images in, 484
Get Photos from Camera command, 475
opening documents with, 16–17, 474
placing graphics from, 262–263
preferences, setting, 482–483
revealing documents in, 16

Web Photo Gallery creation, 485
working with images using, 17, 480–481

Adobe Creative Cloud, 15
Adobe Dreamweaver, 418
Adobe ExtendScript Toolkit, 472, 491
Adobe Extension Manager, 472, 490
Adobe Flash Builder, 31
Adobe Flex File, saving documents as, 

420-421
Adobe Idea File (IDEA), 14-15
Adobe Media Encoder, 488-489
Adobe Mini Bridge, 487
Adobe PDF Presets command (Edit menu),

409
Adobe Product Improvement Program, 25
Adobe Studio Exchange, 2
Adobe SVG Viewer, 418-419
Adobe Updater, 23
Adobe Web site

Adobe Studio Exchange, 2
Community Help, 24

advanced print options, 394–395
Advanced tab (File Info dialog box), 399
alignment

anchor points, 178–179
objects, 96
paragraphs, 246
pixel grid, 67
slices, 447
stroke, 138

All Objects command (Select menu), 90
All Objects in Active Artboard command

(Select menu), 90
anchor points

adding new, 176–177
alignment, 178–179
average, 173
Convert Anchor Point tool, 175
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anchor points (continued)
converting, 174–175
deleting, 177
direction lines, 172
endpoints, 179
highlighting, 172
moving, 172–173
paths and, 65
preferences, 172
selecting with Direct Selection tool, 84
showing and hiding, 65
smooth points, converting to corner

points, 174
anchors, 457
Android (Media Encoder), 488-489
anti-aliasing, 245, 454
Appearance of Black preferences, 468
Appearance panel, 278–279

exporting as CSS3 file, 418-419
Apple devices (Media Encoder), 488-489
Arc tool, 72
arcs, drawing, 72
area graphs, 372-373
Area Type tool, 222, 225
arranging

documents, 20
layers, 208–209
slices, 446–447

arrowheads, stroke, 140-141
art brushes, 324–325
Artboard tool

artboard creation, 36
Artboard Options button, 37
multiple artboards, 38

artboards
within artboards, 36
aspect ratio, 37
centerpoints, 37
deleting, 38
display options, 39
duplicating, 36
exiting editing mode, 36
landscape/portrait orientation, 37
moving, 38
multiple, working with, 38
navigating within, 36
presets, 36
previewing, 38

resizing, 38
rotating, 38
size, 37
switching between, 19, 39
video safe areas, 37
X and Y positioning, 37

artwork, inserting in documents, 18
Assign Profile command (Edit menu), 110
attributes

appearance, 278–279
stroke, 138–141

Audio Data tab (File Info dialog box), 398
auto slices, 440
AutoCAD File format, 403

B
bar graphs, 372-373
batch file processing, 366–367
Batch Rename command, 486
bend styles, 95
bevel bend style, 95
bevel joins, 139
bitmap, exporting documents as, 404
black appearance options, 468
bleed

bleed print option, 389
document creation, 34

Blend command (Objects menu), 151–152
Blend tool, 153
blends

blending fill colors, 150
changing and applying blend options,

152
creating automatically, 151
creating with Blend tool, 153
making and releasing blend objects, 151
objects, modifying, 154
opacity, 155
transformation, 154
transparency settings, 156

Bloat tool, 332
Blob Brush tool

brush options, setting, 189
merging paths with, 188

blur effects, 298-299
BMP format, 403
bold font, 236
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Bounding Box command (View menu),
314–315

Bridge (Adobe)
automating tasks in, 486
browsing documents with, 16
Camera Raw feature, 476–479
color settings, 109
components of, 473
description of, 472
editing images in, 484
Get Photos from Camera command, 475
Mini Bridge, 487
opening documents with, 16–17, 474
placing graphics from, 262–263
preferences, setting, 482–483
revealing documents in, 16
Web Photo Gallery creation, 485
working with images using, 17, 480–481

Bristle brushes, 328-329
creating and editing, 328-329

Browse in Bridge command (File menu),
16–17, 262–263

browser
preview in (Save for Web), 451

brushes
art, 324–325
Blob Brush tool, 189
Bristle, 328-329
Brushes panel, 317
calligraphic, 322–323
deleting, 330
library, saving, 331
Paintbrush tool, 318–319
pattern, 326–327
scatter, 320–321
strokes, removing, 330

Brushes panel, 317
built-in scripts, actions, 368

C
calligraphic brushes, 322–323
Camera Data tab (File Info dialog box), 398
Camera Raw feature, 472, 476–479
canvas (user interface), 465
canvas (Object menu)

HTML5 Canvas (HTML5 Pack), 418

caps, 139
case, text, 383
Categories tab (File Info dialog box), 398
center mark, 39
centerpoints, 37
Character panel, 238-245

formatting type, 244
Character Styles panel, 250-251
Check Spelling command (Edit menu), 378
circles, drawing, 68
clean up unneeded elements, 375
clearing

guides, 51
objects, 93

clipping masks
creating, 194
creating for groups or layers, 195
editing, 196
masked object, editing in Isolation

Mode, 197
release objects from, 195

clipping sets, 197
Close button, 28
Close command (File menu), 28
closed paths, 65
closing

documents, 28
Illustrator, 28
panels, 8-9

CMYK (Cyan, Magenta, Yellow and Black)
color mode, 30, 111, 115

collapsing panels, 8-9
Color Guide panel

applying color with, 128–129
color groups, 129
harmony rules, variations based on, 129
variation options, selecting, 127
variation types, displaying, 127

color management print options, 396
color modes. See also colors

changing, 112
CMYK, 30, 111, 115
document creation, 30
Grayscale, 30, 114
RGB, 30, 111, 114
switching between, 111
working with, 111
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Color panel
Color sliders, 114
working with, 114–115

colored paper simulation, 35
colors. See also Color Guide panel; color

modes; Swatches panel
applying to objects, fills, or stroke, 113,

136-137
applying with Eyedropper tool, 144–145
Color Guide Panel, 127–129
Color panel, 114–115
color profiles, changing or removing, 109
color settings, changing, 108–109
converting to grayscale, 125
crop mark registration color, 56-57
gamut warning icon, 115
global, 124–126
grayscale images, 125
grid colors transparency settings, 35
grids, 54
group, creating, 118-119
guides, 50, 53
hue, 115
inverting, 126
Kuler panel, 122–123
Live Color feature, 130–131
luminosity, 115
nonglobal, 124–126
proofing, 132-133
replacing, 124–125
saturation, 115
selecting, 115
soft proof, 132-133
Swatches panel, 116–121
themes, 122–123
ungroup, 119
view box color, 44
Web-safe, 115

column graphs, 372-373
combining

slices, 448
commands

adding to actions, 364
basic description of, 6-7
deleting from actions, 365
Panel Options menu, 11

Community Help site, 24
compound paths

creating, 192
releasing, 193
reversing object's fill in, 193

condensed font, 236
Constrain Angle general preference, 454
Control panel

anchor points, converting, 175
basic description of, 13
splitting paths using, 186-187
tools in, 6-7

Convert Anchor Point tool, 175
Convert to Shape command (Effect menu),

284
convert to shape effects, 284
converting anchor points, 174–175
Copy command (Edit menu), 233
copying text, 232–233
corner points, 174
Corner Radius general preference, 454
Create New Action button (Actions panel),

359
Create New Set button (Actions panel), 359
crop marks

creating, 56-57
deleting, 56
general preferences, 455
registration color, 56
trim marks, editable, 57

cross hairs, 39
Crystallize tool, 332
CSS (Cascading Style Sheets)

exporting as CSS3 file, 418-419
setting properties, for SVG, 417

cursor preferences, 454
curved segments, 173
curves, drawing, 171
custom dictionaries, spell checking, 379
Cut command (Edit menu), 233
cutout effects, 300

D
dashed stroke, 140
data graphs, 372-373
data sets

creating, 370–371
deleting, 370–371
renaming, 371
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data variables, 370–371
deactivate Illustrator, 22
Delete button (Actions panel), 359
deleting

anchor points, 177
artboards, 38
brushes, 330
commands from actions, 365
crop marks, 56-57
data sets, 370–371
files, 14
graphic styles, 277
layers, 205
objects, 93
selections, 92
slices, 442
symbols, 337
workspaces, 61

Description tab (File Info dialog box), 398
Deselect command (Select menu), 90
dialogs

Reset All Warning Dialogs, 455
DICOM tab (File Info dialog box), 399
dictionary preferences, 462
dictionaries, spell checking, 379
diffuse glow effects, 301
Direct Selection tool

anchor points, adding new, 176
anchor points or segments, moving, 173
deleting anchor points using, 177
end points, connecting, 179
selecting anchor points and segments

with, 84
showing/hiding direction lines, 65
understanding selections, 82

direction lines
anchor points, 172
showing and hiding, 65

Distort & Transform command (Effect
menu), 102, 291

distributing
objects, 96
slices, 447

dithering, 435
dividing 

paths, 185
slices, 448

drawing mode, 66

behind, 66
normal, 66
inside, 66

DOC format, 229
docking

documents, 21
panels, 10

Document Color Mode command (File
menu), 112, 384

Document Info panel, 400
Document Setup command (File menu), 34,

159
Document window, 6-7
documents

active, 21
arranging, 20
bleed and view options settings, 34
browsing with Adobe Bridge, 16
closing, 28
color modes, 30
creating

from scratch, 30
from templates, 32–33
using presets, 31

docking/undocking, 21
exporting

as bitmap, 404
Export command, 402
export file formats, 403
as Flash Movie, 410–411
to Photoshop, 408
with presets, 409
as TIFF format, 405

file information, inserting, 398–399
finding and replacing text and elements

in, 380–381
grid pattern, 21
inserting images in, 18
language settings, 35
linking, 18
measurement units, 34
opening

with Adobe Bridge, 16–17
existing documents, 14
recently opened, 15

printing, 384
revealing in Adobe Bridge, 16
rulers, 48–49
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documents (continued)
saving, 26–27

as Adobe Flex File, 420-421
as EPS format, 414–415
as FXG format, 420-421
as Microsoft Office, 422
as PDF format, 412–413
as SVG format, 416-418
as template, 423
for the Web, 426–427

setting up, 34–35
spell checking, 378–379
switching between, 20
tabbed, 20
templates, 18
transparency settings, 34–35
type options settings, 35
view size, 19
viewing information in, 19
views, 40–43
windows, 20–21
working with multiple, 20–21

DOCX format, 229
double quotes, 35
drawing

arcs, 72
circles, 68
curves, 171
ellipses, 68
line segments, 71
with Pencil tool, 304–305
polygons, 70, 170
rectangle grids, 74
rectangles, 69
spirals, 72–73
stars, 70

drawing tablets, 470
drop shadow effects, 287
duplicating

artboards, 36
color in Swatches panel, 117
graphic styles, 275
layers, 210
objects, 94–95
slices, 442, 448
symbols, 338

E
Edit Colors command (Edit menu), 126, 150
Edit Custom Dictionary command (Edit

menu), 379
Edit menu commands

Adobe PDF Presets, 409
Assign Profile, 110
Check Spelling, 378
Color Settings, 108
Copy, 233
Cut, 233
Edit Colors, 126, 150
Edit Custom Dictionary, 379
Find and Replace, 380–381
Paste, 232–233
Paste in Back, 233
Paste in Front, 233
Print Presets, 385
Redo, 59
Transparency Flattener Presets, 395
Undo, 59

Edit Selection command (Select menu), 92
Edit View command (View menu), 40
editing

blend objects, 154
clipping masks, 196
color in Swatches panel, 117
colors with Live Color, 130–131
gradients, 164
graphic styles, 276
images in Adobe Bridge, 484
paths within clipping sets, 197
patterns, 148
selections, 92
symbols, 339

Effect menu commands
Convert to Shape, 284
Crop Marks, 56
Distort & Transform, 102
Effect Gallery, 294–297
Stylize, 285

effects
accented edges, 301
applying multiple, 296
blur, 298-299
controlling with selections, 297
convert to shape, 284
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cutout, 300
diffuse glow, 301
distort, 291
drop shadow, 287
dry brush, 300
Fresco, 300
gaussian blur, 298-299
glass, 301
glowing edges, 301
grain, 302
graphic pen, 302
Illustrator, 282–283
inner glow, 286–287
mosaic tiles, 302
note paper, 301
outer glow, 286–287
panel knife, 300
Photoshop Effect Gallery, 294–295
plastic wrap, 302
previewing, 282
raster graphics, 292
scribble, 285
spatter, 302
stained glass, 302
stamp, 301
text, 228
transform, 291
3D, 288–289
vector objects, 293
warp, 290

Ellipse tool, 68
ellipses, drawing, 68
embedded graphics, 266–267
endpoints, 179
Enhanced Metafile format, 403
Envelopes, reshaping with, 104-105
EPS format, 27, 399, 414–415
Eraser tool, 182
erasing path parts, 182
exiting Illustrator, 28
Expand button (Pathfinder panel), 190
Expand command (Objects menu), 160-161
expanding

gradients, 160-161
panels, 8-9
patterns, 149

ExportDocsAsFlash, script, 368–369

exporting
documents

as bitmap, 404
as CSS3, 418-419
Export command, 402
as Flash Movie, 410–411
as JPEG, 406-407
to Photoshop, 408
as PNG, 406-407
with presets, 409
as TIFF format, 405

export file formats, 403
ExtendScript Toolkit, 472, 491
Extension Manager (Adobe), 472, 490
Extensions command (Window menu),

122–123
Eyedropper tool

applying colors and attributes with,
144–145

color attributes, changing, 145
Save for Web tool, 428-429

F
families, font, 236
File Handling & Clipboard preferences, 

466-467
File Info command (File menu), 398
file information, inserting into documents,

398–399
File menu commands

Browse in Bridge, 16–17, 262–263
Close command, 28
Device Center, 41
Document Color Mode, 112, 384
Document Setup, 34, 159
File Info, 398
New, 30–31
New From Template, 32
Open, 14, 260
Open Recent, 15
Open With, 262
Place, 18, 261, 264, 266
Print, 384, 386
Return to Adobe Illustrator, 16
Revert, 26
Save, 26
Save a Copy, 27
Save As, 27, 33
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File menu commands (continued)
Save for Web, 426–429, 430-431
Scripts, 368–369

files
deleting, 14
formats (Save for Web), 426-431
images, optimizing to file size (Save for

Web), 439
saving actions as, 359

fills
applying color to, 113, 128, 136-137
blending fill colors, 150
patterns as, 146–149

Find and Replace command (Edit menu),
380–381

Find Font command, 382
Fire/Nook device, 31
Fit All In Window command (View menu),

46
Fit Artboard In Window command (View

menu), 46
Flare tool, 69
Flash Builder, 31
Flash format, SWF, 403, 410-411
Flash Movie, exporting documents as,

410–411
Flash (Media Encoder), 488-489
Flattener Preview command (Window

menu), 41, 395
flattening layers, 216
flattening object transparency, 158
fonts

bold, 236
condensed, 236
families and styles, 236
Find Font command, 382
finding, 237
italic, 236
OpenType fonts, 254
replacing, 237
reusing recent, 236
size, 238

formatting type, 244
Freehand format, 14
Free Transform tool, 98–99
Fresco effects, 300
full screen mode, 45
FXG format, 27, 420-421

G
gamut warning icon, 115
Galaxy S device, 31
Gap options, 316
gaussian blur effects, 298-299
General preferences, 454
Get Photos from Camera command

(Adobe), 475
GIF documents, optimizing, 434–435
GIF format, 399
glass effects, 301
global colors, 124–126
glowing edges effects, 301
glyphs, 253
Go to Bridge button, 16–17
GPS Data tab (File Info dialog box), 398
Gradient tool, 165
gradients

applying to objects, 160-161
creating, 163
editing, 164
expanding, 160-161
fill, 160
Gradient Annotator, 165
Gradient tool, 165
libraries, using, 162
linear type, 163
mesh, 104-105, 166-167
radial type, 163
stroke, 161

grain effects, 302
graphic pen effects, 302
graphics

embedded, 266–267
linked, 266–267
linking, 264–265
mosaic, 280
opening graphic images, 260
placing, 261–263
print options, 390
raster

interpolation and, 64
tracing, 268–272
understanding raster graphics, 64

styles
applying, 273
breaking links to, 277
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creating, 274
deleting, 277
duplicating, 275
editing, 276

graphs, 372-373
add designs, 374
create and format, 372-373

Grayscale color mode, 30, 114
grayscale images, 125
grid colors transparency settings, 35
grid patterns, 21
Grid, Perspective

adjusting, 79
copying, 80
customizing, 81
drawing, 78
moving, 80
objects, adding, 80
resizing, 80
text, adding, 80

grid, pixel aligned, 67
grid size transparency setting, 34
grids. See also guides

color, 54
displaying in back of artwork, 54
Polar Grid tool, 75
preferences, 54
Rectangle Grid tool, 74
showing and hiding, 54
Snap to Grid command, 54
styles, 54
subdivisions, 54
Transparency, 159

Group command (Objects menu), 88
Group Selection tool, 82
grouping objects, 88–89
groups

creating clipping masks for, 195
colors, creating in the Swatches panel,

118-119
guides. See also grids

clearing, 51
color, 50
converting vector objects to, 51
creating, 51
locking, 50
preferences, 50
ruler, 49

showing and hiding, 50
smart guides

object transformation, 99
preferences, 53
turning on/off, 52
working with, 52–53

snap to point, 50
style, 50
switching, 51

H
Hand tool

moving elements around with, 55
quick access to, 55
Save for Web tool, 428-429

handles, 457
hanging indents, 247
hardware, Illustrator system 

requirements, 3
Help menu commands

Adobe Product Improvement Program,
25

Illustrator Help, 24–25
Updates, 23

help options
Community Help site, 24
searching topics, 25

Hide Edges command (View menu), 65
Hide Panels command (Window menu), 20
hiding

anchor points, 65
direction lines, 65
grids, 54
guides, 50
layers, 212
panels, 10, 45
rulers, 49
slices, 442–443
Transparency grid, 159

highlighting anchor points, 172
histograms, 479
History tab (File Info dialog box), 399
HSB color slider (Color panel), 114
HTML text, adding to slices, 444
HTML5 Pack, 418-419

exporting as CSS3, 419
saving as SVG, 418
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hue, 115
hyphenation, 249, 462
hyphenation preferences, 462

I
icons, collapsing and expanding panel sets

between icons and panels, 11
Illustrator Help command (Help menu),

24–25
Illustrator tab (File Info dialog box), 399
images

inserting in documents, 18
replacing, 18
working with images using Bridge, 17

ImageTracing, script, 368–369
image tracing options, 268-271
Image Trace panel, 268-271
importing text, 229
indentation

hanging indents, 247
paragraphs, 247

Info panel
color fill and stroke information, 58
uses for, 58

inner glow effects, 286–287
iPad device, 31

Media Encoder, 488-489
IPTC tab (File Info dialog box), 398
IPTC Extension tab (File Info dialog box),

398
iPhone device, 31

Media Encoder, 488-489
installing Illustrator

in Macintosh, 3
in Windows, 2

Internet, checking for updates from, 22
interpolation, 64
Inverse command (Select menu), 90
inverting colors, 126
IPTC tab (File Info dialog box), 398
Isolation Mode, 197
italic font, 236

J
JavaScript, 416-418
joining anchor endpoints, 179
joins, 139

JPEG documents, optimizing, 432–433
JPEG format, 399, 403

exporting as, 406-407
justification options, 255

K
kerning type, 240
Keyboard Increment general preference,

454
keyboard shortcuts, 469
Knife tool, 185
Knockout Group option, 156
Kuler panel, 122–123

L
landscape/portrait orientation, 37
language settings, document creation, 35
Lasso tool

selecting objects with, 85
understanding selections, 82

layers. See also Layers panel
arranging, 208–209
creating clipping masks for, 195
creating top level layers, 202–203
deleting, 205
deselecting, 204
duplicating, 210
flattening, 216
hiding, 212
locking, 211
merging, 213
moving, 208–209
moving objects to, 214–215
naming, 203
outlines, viewing, 219
Paste Remembers Layers, 214
releasing objects to, 215
reverse order, 208
selecting, 204
selecting objects with, 206–207
showing and hiding, 212
sublayers, 202–203
template, creating, 218

Layers panel. See also layers
accessing, 200
components of, 200
locating objects in, 217
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options, setting, 201
layouts, workspace, 60
leading text, 239
libraries

brushes, saving, 331
gradients, 162

ligature, 255
line graphs, 372-373
Line Segment tool, 71
line segments, drawing, 71
linear gradient type, 163
linked graphics, 266–267
linking

documents, 18
graphics, 264–265
slices, 443

Liquify tools, 335
Live Color feature

applying color groups to objects with,
130–131

editing colors with, 130–131
Live Paint Bucket tool

paint fills, 310
preferences, setting, 309
selecting options to paint fills or strokes

with, 308
stroke edges, changing, 311

Live Paint Groups
adding paths to, 315
converting traced objects to, 307
creating, 306–307
Gap options, 316
reshaping or moving paths in, 314–315

Live Paint Selection tool, 312–313
locking, 211
guides, 50
layers, 213

lossy compression, 435
lowercase text, 383
luminosity, 115

M
Macintosh

Illustrator system requirements, 3
installing Illustrator in, 3
starting Illustrator in, 5

Macintosh PICT format, 403

Magic Wand tool
selecting objects with, 86–87
understanding selections, 82

marks print options, 388–389
Measure tool, 58
measurement

distance between objects, measuring, 58
measurement units, document creation,

34
Media Encoder, 488-489
menus, 6-7
merging

layers, 213
paths, 188–189

mesh, 104-105, 166-167 
metadata, 398-399
Microsoft Office, saving documents as, 422
Mini Bridge, 487
miter bend style, 95
miter joins, 139
Mobile SWF tab (File Info dialog box), 398
mode, drawing, 66
mosaic tiles effects, 280, 302
Move tool, 52
moving

anchor points, 172–173
artboards, 38
document elements with Hand tool, 55
layers, 208–209
objects, 93
objects to layers, 214–215
segments, 172–173
slices, 446
text, 227, 232–233
between tools, 55

N
naming

layers, 203
selections, 92
workspaces, 60

navigation
artboards, 39
within artboards, 36

Navigator panel
customizing, 44
view area, 43
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Navigator panel (continued)
view box color, 44
view size, 42

New command (File menu), 30–31
New From Template command (File menu),

32
New View command (View menu), 40
Next Object Above command (Select

menu), 90
Next Object Below command (Select

menu), 90
9-slice scaling, 352-353
nonglobal colors, 124–126
non-recordable command in an Action, 363
normal screen mode, 45
note paper effects, 301

O
objects

alignment, 96
applying color to, 113, 128, 136-137
clearing, 93
deleting, 93
distributing, 96
duplicating, 94–95
grouping, 88–89
measuring distance between, 58
moving, 93
moving to layers, 214–215
Perspective Grid

adjusting, 79
copying, 80
customizing, 81
drawing, 78
moving, 80
objects, adding, 80
resizing, 80
text, adding, 80

pixel grid, aligned, 67
reflecting, 97, 101
rotating, 97–98, 100
scaling, 97, 100
selecting

with Lasso tool, 85
with Magic Wand tool, 86–87
similar objects, 90–91
using Direction Selection tool, 84

using Select menu, 90–91
using Selection tool, 83

Shape Builder tool, 76-77
transforming, 97–99

Objects menu commands
Blend, 151–152
Clipping Mask, 194
Compound Path, 192
Expand, 160-161
Group, 88
Text Wrap, 256
Transform, 102
Ungroup, 88

offsetting paths, 95, 187
opacity, blends, 155
opacity mask, transparency, 157
Open command (File menu), 14, 260
open paths, 65, 177
Open Recent command (File menu), 15
OpenType fonts, 254
Open With command (File menu), 262
opening

documents
with Adobe Bridge, 16–17
existing documents, 14
recently opened, 15

graphic images, 260
panels, 8-9

optimizing
images to file size (Save for Web), 439

Origin tab (File Info dialog box), 399
outer flow effects, 286–287
Outline view, 40–41
outlines, 257
outlines, viewing layers as, 219
output print options, 392–393
overflow, text, 234–235
Overprint Preview command (View menu),

41, 391

P
Paintbrush tool, 181
painting

art brushes, 324–325
Brushes panel, 317
calligraphic brushes, 322–323
Live Paint Bucket tool, 308–311
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Live Paint Groups
adding paths to, 315
converting traced objects to, 307
creating, 306–307
Gap options, 316
reshaping or moving paths in,

314–315
Live Paint Selection tool, 312–313

Paintbrush tool, 318–319
pattern brushes, 326–327
scatter brushes, 320–321

panel knife effects, 300
Panel Options menu, 8-11
panels

adding, 10
closing, 8-9
collapsing, 8-9, 11
displaying hidden, 45
docking/undocking, 10
expanding, 8-9, 11
hiding, 10, 45
opening, 8-9
Panel Options menu, 11
resizing, 8-9
sets, collapsing and expanding between

icons and panels, 11
subtracting, 10

paragraphs
alignment, 246
indentation, 247
spacing, 247

Paragraph panel, 246-247, 249
Paragraph Styles panel, 250-251
Paste command (Edit menu), 232–233
Paste in Back command (Edit menu), 233
Paste in Front command (Edit menu), 233
Pathfinder commands, 191
Pathfinder panel, 190-191
paths

anchor points and, 65
clean up unneeded elements, 375
clipping mask, 194–197
closed, 65
compound, 192–193
convert mesh object to, 174
convert strokes to compound, 192
dividing, 185
erasing parts of, 182, 304

join, 179
merging, 188–189
offsetting, 95, 187
open, 65, 177
outline stroke, 181
reshaping, 180–181
segments and, 65
Shape Mode command, 190
shape of, changing, 65
simplify, 184
smoothing, 183
splitting, 186–187
splitting into grid, 187

pattern brushes, 326–327
patterns

applying to objects, 149
creating, 146-147
editing, 148
expanding, 149
as fills, 149
as strokes, 149

PDF format, 27 
saving as, 399, 412–413
SaveDocsAsPDF, script, 368–369

Pen tool
anchor points, adding, 177
drawing curves with, 171
drawing polygons with, 170

Pencil tool
preferences, 305
reshaping paths with, 181
working with, 304–305

Perspective Grid
adjusting, 79
copying, 80
customizing, 81
drawing, 78
moving, 80
objects, adding, 80
resizing, 80
text, adding, 80

Photoshop Effect Gallery, 294–295
Photoshop, exporting to, 408
Photoshop format, 403
pie graphs, 372-373
pixel grid, align, 30, 67, 354
Pixel Preview command (View menu), 41
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pixels, 37
Place command (File menu), 18, 261, 264,

266
placing graphics, 261–263
plastic wrap effects, 302
Play button (Actions panel), 359
playback, action, 361
plug-in preferences, 463
PNG format, 399, 403

exporting as, 406-407
PNG-8 document, 436–437
PNG-24 document, 438
point type, 223
point/pica size, 48
points, anchor

adding new, 176–177
alignment, 178–179
average, 173
Convert Anchor Point tool, 175
converting, 174–175
deleting, 177
direction lines, 172
endpoints, 179
highlighting, 172
moving, 172–173
paths and, 65
preferences, 172
selecting with Direct Selection tool, 84
showing and hiding, 65
smooth points, converting to corner

points, 174
Polar Grid tool, 75
Polygon tool, 70
polygons, drawing, 70, 170
portrait/landscape orientation, 37
preferences

Adobe Bridge, 482–483
anchor points, 172
Appearance of Black, 468
cursor, 454
dictionary, 462
File Handling & Clipboard, 466-467
General, 454
grids, 54
guide, 50
hyphenation, 462
keyboard shortcut, 469
Live Paint Bucket tool, 309

Pencil tool, 305
plug-in, 463
ruler, 48
Scratch Disk, 464
Selection & Anchor Display, 456–457
slices, 461
smart guides, 53
text, 458–459
Transparency grid, 159
type, 458–459
Units Performance, 460
updates, 22
user interface, 465

presets
artboard, 36
creating new documents using, 31
exporting with, 409
list of, 31
printing with, 385, 394

Preview in browser (Save for Web), 451
Preview view, 40–41
Preview View command (View menu), 304
previewing

artboards, 38
color separations, 391
effects, 282
Save for Web, 451

Print command (File menu), 384, 386
Print Presets command (Edit menu), 385
printing

advanced print options, 394–395
bleed options, 389
color management settings, 396
color separations, previewing, 391
documents, 384
general print options, 386–387
graphics print options, 390
marks options, 388–389
number of copies, specifying, 387
output options, setting, 392–393
Overprint preview, 391
overprints, 394
presets, 394
with presets, 385
Print command, 384
print problems, checking for, 397
print tiling, 387
reverse order, 386
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Separations preview, 391
summary print options, 397

Product Improvement Program (Adobe), 25
Proof Colors command (View menu), 

132-133
Proof Setup command (View menu), 41
proofing colors, 132-133
PSD format, 399
Pucker tool, 332
punctuation, 252

Q
Quit Illustrator command (Illustrator menu),

28
quotes, 35

R
radar graphs, 372-373
Radial Blur, 298-299
radial gradient type, 163
raster graphics

effects, 283, 292
interpolation and, 64
Resolution Independent Effects (RIE), 283
tracing, 268–272
understanding raster graphics, 64

Record button (Actions panel), 359
recording actions, 360
Rectangle Grid tool, 74
Rectangle tool, 69
Redo command (Edit menu), 59
Reflect tool, 101
reflecting objects, 97, 101
registration, 4–5
registration point, 355
releasing

compound paths, 193
objects from clipping masks, 195
objects to layers, 215

renaming
data sets, 371
selections, 92
workspaces, 61

rendering intent color management print
option, 396

replacing
colors, 124–125

fonts, 237
images, 18

Reselect command (Select menu), 90
Reset All Warning Dialogs, 455
Reshape tool, 180
reshaping objects, with Envelopes, 104-105
reshaping paths, 180–181
resizing

artboards, 38
slices, 446

Resolution Independent Effects (RIE), 283
resolution preset transparency setting, 35
Return to Adobe Illustrator command (File

menu), 16
reverse order printing, 386
Revert command (File menu), 26
revolving 3D effects, 289
RGB (Red, Green, Blue) color mode, 30, 111,

114
Rotate tool, 100
rotating

artboards, 38
objects, 97–98, 100
text, 243

round bend style, 95
round joins, 139
Rounded Rectangle tool, 69
RTF format, 229
rulers

artboard display options, 39, 49
displaying, 48–49
document, 48–49
guides

alignment, 53
changing, 49
clearing, 51
color, 50
converting vector objects to, 51
creating, 51
locking, 50
preferences, 50
ruler, 49
showing and hiding, 50
smart guides, 52–53
snap to point, 50
style, 50
switching, 51

hiding, 49
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rulers (continued)
origin, changing, 49
preferences, 48

S
safe area, artboard display options, 39
Same command (Select menu), 91
saturation, color, 115
Save a Copy command (File menu), 27
Save As command (File menu), 27, 33
Save command (File menu), 26
SaveDocsAsPDF, script, 368–369
SaveDocsAsSVG, script, 368–369
Save for Web command (File menu),

426–429
as GIF format, 426-427, 434-435
as JPEG format, 426-427, 432-433
as PNG-8 format, 426-427, 436-437
as PNG-24 format, 426-427, 438

Save Selection command (Select menu), 82
Save Workspace command (Workspace

menu), 60
saving

actions
as files, 359
into sets, 359

brush library, 331
documents, 26–27

as Adobe Flex File, 420-421
as EPS format, 414–415
as FXG format, 420-421
as Microsoft Office, 422
as PDF format, 412–413
as SVG format, 416-418
as template, 423
for the Web, 426–427

selections, 82
slices for Web, 449
slices (from selection) for Web, 450
symbols, 337

Scale Strokes & Effects option, 455
Scale tool, 100
scaling

9-slice scaling, 352-353
objects, 97, 100
type, 242

Scallop tool, 332

scatter brushes, 320–321
scatter graphs, 372-373
Scissor tool, 186
Scratch Disk preferences, 464
screen modes, 45
scribble effects, 285
scripts, actions, 368–369
searching

fonts, 237
for help information, 25

segments
curve, 173
moving, 172–173
paths and, 65
selecting with Direct Selection tool, 84

Select menu commands, 90–91
Edit Selection, 82
Same command, 91
Save Selection, 82

Selection & Anchor Display preferences,
456–457

Selection tool. See also selections
aligning and distributing objects using,

96
duplicating objects with, 94–95
moving objects with, 93
reflecting or shearing objects, 101
rotating and scale objects with, 100
selecting objects with, 83
transforming objects with, 97
understanding selections, 82

selections. See also Selection tool
anchor points, 84
controlling effects using, 297
deleting, 82
editing, 82
examples of, 82
inverting color of, 90
layers, 204
naming, 82
renaming, 82
reselecting, 90
saving, 82
selecting next object above/below 

current, 90
slices, 442–443
type, 230–231
understanding selections, 82
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sentence case, 383
Separations Preview command (Window

menu), 41
Shape Mode command (Pathfinder panel),

190
Shape Builder tool, 76-77
Shear tool, 101
shortcuts

starting Illustrator, 4–5
tool, 13

Show Bounding Box command (View
menu), 97

Show Edges command (View menu), 65
Show Panels command (Window menu), 20
Show Print Tiling command (View menu),

40
Show Text Threads command (View menu),

234
Show Transparency Grid command (View

menu), 159
simplify paths, 184
single quotes, 35
size

artboard, 37
font, 238
views, 42

Slice tool, 440
Slice Selection tool, 442
Slice Select tool (Save for Web), 428-429,

443
slices

alignment, 447
arranging, 446–447
auto, 440
combining, 448
deleting, 442
distributing, 447
dividing, 448
duplicating, 442, 448
hiding, 442–443
HTML text, adding, 444
images, optimizing to file size, 439
linking, 443
moving, 446
preferences, 461
resizing, 446
saving for Web, 449, 450
selecting, 442–443
showing, 442–443

stacking, 447
subslices, 441
unlinking, 443
URL links, adding, 445
user, 440
viewing slice options, 442–443
working with, 443

Smart Blur, 298-299
smart guides

object transformation, 99
preferences, 53
turning on/off, 52
working with, 52–53

Smart Punctuation, 252
smooth paths, 183
smooth points, converting to corner points,

174
Snap to Grid command, 54
Snap to Point command, 50, 456
soft proof colors, 132-133
software, Illustrator system requirements, 3
spacing paragraphs, 247
spatter effects, 302
spell checking, 378–379
Spiral tool, 72–73
spirals, drawing, 72–73
splitting paths, 186–187
stacked bar graphs, 372-373
stacked column graphs, 372-373
stacking slices, 447
stained glass effects, 302
stamp effects, 301
Star tool, 70
stars, drawing, 70
Start menu, opening documents using, 15
starting Illustrator

in Macintosh, 5
shortcuts, 4–5
in Windows, 4

status bar, 19
Stop button (Actions panel), 359
stops, adding to actions, 362
stroke

alignment, 138
applying color to, 113, 128, 136-137
arrowheads, 140-141
attributes, changing, 138–141
caps or joins, changing, 139
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stroke (continued)
dashed, 140
patterns as, 146–149
weight of, changing, 138
widths, variable, 142-143

styles
font, 236
graphic

applying, 273
breaking links to, 277
creating, 274
deleting, 277
duplicating, 275
editing, 276

grids, 54
guides, 50
type, 250–251

Stylize command (Effect menu), 285
sublayers, 202–203
subscript text, 35
subslices, 441
subtracting panels, 10
summary print options, 397
superscript text, 35
SVG format, 27

HTML5 Pack, 418
saving as, 416-417
SaveDocsAsSVG, script, 368–369

Swatches Library
copying swatches between libraries, 120
customized swatch panels, saving, 121
displaying, 120
gradient library, 160, 162

Swatches panel
creating color groups in, 117
deleting colors from, 116
display of, changing, 116
editing or duplicating color in, 117
groups, creating, 118-119
sorting colors in, 116
swatches, displaying by type, 116
Swatches Library, 120–121

SWF format, Flash, 403, 410-411
symbols

9-slice scaling, 352-353
creating, 336
deleting, 337

duplicating, 338
editing, 339
links, breaking, 340–341
pixel grid, align, 354
registration point, 355
saving, 337
sets, expanding instances of, 351
Symbol Libraries, 335
Symbol Screener tool, 349
Symbol Scruncher tool, 345
Symbol Shifter tool, 344
Symbol Sizer tool, 346
Symbol Spinner tool, 347
Symbol Sprayer tool, 342
Symbol Strainer tool, 348
Symbol Styler tool, 350
symbolism tool options, setting, 343
Symbols panel, 334

Symbol Libraries, 335
Symbol Screener tool, 349
Symbol Scruncher tool, 345
Symbol Shifter tool, 344
Symbol Sizer tool, 346
Symbol Spinner tool, 347
Symbol Sprayer tool, 342
Symbol Strainer tool, 348
Symbol Styler tool, 350
system requirements, 3

T
tab stops, 248
tabbed documents, 20
tabs, 248
Tabs panel, 248
Targa format, 403
templates

creating documents from, 32–33
document, 18, 32–33
saving documents as, 423

template layer, creating, 218
text

anti-aliasing, 236, 245
case, 383
clean up unneeded elements, 375
copying, 232–233
effects, 228
fonts, 236–238
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glyphs, 253
hyphenation, 249
importing, 229
justification, 255
kerning, 240
leading, 239
moving, 227, 232–233
outlines, 257
overflow, 234–235
paragraphs, 246–247
preferences, 458–459
rotating, 243
scaling, 242
selecting, 230–231
spacing, 255
styles, 250–251
subscript, 35
superscript, 35
tabs, 248
threads, 234–235
tracking, 241
typing new, 223–224
wrapping, 256

Text Format, 403
Text Wrap command (Objects menu), 256
themes, color, 122–123
threads, text, 234–235
3D effects, 288–289
thumbnail views, 43
TIFF format, 399, 403, 405
Tolerance selection option, 456
tool tips, 455
tools

accessing in Tools panel, 12
accessing multiple, 12
Control panel, 6-7
moving between, 55
shortcuts to, 13

Tools panel
accessing tools in, 12
contents of, 6-7

tracing raster graphics, 268–270
tracking type, 241
transformations

applying multiple, 102–103
blends, 154
Distort & Transform command, 102

repeating, 102
Transform Each command, 102

transforming objects, 97–99
Transparency Flattener Presets command

(Edit menu), 395
Transparency grid, 159
transparency settings

blends, 156
colored paper simulation, 35
controlling transparency effects, 156
document creation, 34–35
flattening object transparency, 158
grid colors, 35
grid size, 34
opacity mask, 157
resolution preset, 35

trim marks, editable, 57
turning on/off smart guides, 52
TXT format, 229
type

anti-aliasing, 236, 245
Area Type tool, 225
copying, 232–233
deleting empty text paths, 232
fonts, 236–238
justification, 255
kerning, 240
leading, 239
moving, 232–233
OpenType fonts, 254
outlines, 257
overflow, 234–235
paragraphs, 246–247
preferences, 458–459
rotating, 243
scaling, 242
selecting, 230–231
spacing, 255
styles, 250–251
threads, 234–235
tracking value, 241
Type on a Path tool, 226
Vertical Area Type tool, 225
Vertical Type on a Path tool, 226
Vertical Type tool, 223
wrapping, 256

Type on a Path tool, 222, 226
Type tool, 222-223
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typographer's quotes, 35
Twirl tool, 332

U
Undo command (Edit menu), 59
undocking

documents, 21
panels, 10

Ungroup command (Objects menu), 88
ungroup, color group, 119
Units Performance preferences, 460
Updater (Adobe), 23
updates

checking for, 22–23
preferences, 22

Updates command (Help menu), 23
updating, from previous versions, 2
uppercase text, 383
URL links, adding to slices, 445
user interface 

changing, 6-7
preferences, 6-7, 465

user slices, 440

V
variables, data

creating, 370–371
deleting, 370–371
renaming, 371

variable stroke widths, 142-143
vector objects

converting to guide, 51
effects, 293
understanding vector graphics, 64

Vertical Area Type tool, 222, 225
Vertical Type on a Path tool, 222, 226
Vertical Type tool, 222, 223
Video Data tab (File Info dialog box), 398
video safe areas, artboards, 37
View menu commands

Bounding Box, 314–315
Edit View, 40
Fit All In Window, 46
Fit Artboard In Window, 46
Hide Edges, 65
New View, 40
Overprint Preview, 41

Pixel Preview, 41
Preview View, 304
Proof Colors, 132-133
Proof Setup, 41
Rulers, 48
Show Bounding Box, 97
Show Edges, 65
Show Print Tiling, 40
Show Text Threads, 234
Show Transparency Grid, 159
Smart Guides, 52
Soft Proof, 132-133

view size, documents, 19
views

box color, 44
changing, with Zoom tool, 46–47
display view, changing, 40–41
document, 40–43
fit in window, 46
Outline, 40–41
Preview, 40–41
ruler options, 48
size, 42
thumbnail, 43

Vimeo (Media Encoder), 488-489

W
Warp effect, 290
Warp tool, 332
Web

browser preview in (Save for Web), 451
file formats, 430–431
GIF files, optimizing, 426-427, 434–435
images, optimizing to file size, 439
JPEG files, optimizing, 426-427, 432–433
PNG-8 files, optimizing, 426-427, 436–437
PNG-24 files, optimizing, 426-427, 438
saving documents for, 426–427
saving slices for, 449

Web-safe color, 115
Window menu

Extensions, 122–123
Flattener Preview, 41
panel display, 8–10

Window menu commands
Flattener Preview, 395
Hide Panels, 20
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Separations preview, 41
Show Panels, 20

Windows
Illustrator system requirements, 3
installing Illustrator in, 2
starting Illustrator in, 4

windows
active, 20
document, 20–21

Windows Metafile format, 403
Workspace menu commands, 60
workspaces

creating, 60
deleting, 61
displaying, 60
layouts, 60
naming, 60
renaming, 61

wrapping text, 256
Wrinkle tool, 332

X
X and Y positioning, 37
XMP metadata, 398-399
XMP Software Development Kit, 399
Xoom device, 31

Y
YouTube (Media Encoder), 488-489

Z
zoom

in/out, 47
using Navigator thumbnail, 43
view size, 42

Zoom tool
changing view with, 46–47
Save For Web tool, 394
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